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About Adagio Accounting
Adagio by Softrak is a modular, batch-oriented, and powerful accounting software system. Adagio offers
full departmental accounting that is easy to learn, with form and keyboard-oriented data entry, tight audit
trails and unsurpassed flexibility with reports.
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Adagio Receivables offers complete receivables management for your business. Whether you bill time or
sell products, Adagio Receivables allows user-defined aging, customizable statements, and unlimited
notes and alerts for an account. Manage your client accounts with complete aging and analysis reports.
Customer statistics allow you to identify your best clients. Statements and automatic interest processing
encourage prompt payment. Simple point and click inquiries with drill-down to matching transaction detail
speed response to your clients' questions regarding their account status or that of specific invoices

About this Courseware
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This courseware is designed to serve multiple functions. It is designed to be used in conjunction with the
documentation provided with the software. While you can use this courseware to learn the fundamentals
of Adagio Receivables, you can also use it as a reference tool in your everyday work with this module.
Since this courseware is focused on the day to day operation of Adagio Receivables, data files have been
provided for you representing a company for which the accounting system has already been set up.
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While this guide is thorough, it is not encyclopedic and comprehensive. It does not describe the tasks
that should only be performed by an authorized Adagio Accounting service provider. If you have an
Adagio Consultant Reseller (“ACR”), your ACR will be able to provide the necessary services to setting up
your Adagio Receivables system. While this courseware does provide you with all of the information you
need to become an efficient and successful user of Adagio Receivables, it cannot answer every potential
question you might have. However, it will instruct you in the module's concepts and functions so that you
can adapt to new challenges as they arise.
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While using this courseware, you can press F1 for context sensitive help in the function you are currently
in. Full product manuals are available online at http://softrak.com/products/
documentation.php.

FO

The courseware includes references to ‘Show me how” videos provided by Softrak Sytems Inc. with
references to videos indicated by the
icon.
Training data that accompanies the Using Adagio series of training guides can be downloaded from
www.lng.bc.ca/downloads.

Prerequisite Skills
This training resource assumes that you have a working knowledge of the Windows operating system and
its conventions. This knowledge includes how to use the mouse, menus, dialog boxes and how to work
with files. For assistance with questions pertaining to the operating system, you should refer to your
Windows documentation.
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How to Submit Comments and Suggestions
At LNG Management Services, the primary purpose of our courseware is to increase your productivity in
the workplace. In order to meet this goal, we constantly review our work to ensure that we produce the
best guides possible.
If you have any comments or suggestions, please contact us as by sending an email to
comments@lng.bc.ca.
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For additional information on our available courseware and training sessions, please visit our website at
www.lng.bc.ca.
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Lesson 1 - Adagio Receivables Overview
Adagio Receivables’ central purpose is to manage the customer accounts of organizations by keeping
track of what customers owe. The tools included in Adagio Receivables include printing monthly
customer statements that can be mailed, faxed or emailed, and the ability to keep notes within the
customer records that can be used for keeping a record of communication with various contacts within the
customers' organization.

LY

In many cases, companies and organizations will have an invoicing program from which customer billings
are generated and a cash management program from which customer receipts are processed. If
Receivables is being used without any of these programs, invoices and receipts are entered in batches
within the Receivables module.

Creating Batches

O
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The following table describes the primary functions performed in Adagio Receivables:

A variety of batches can be used in Receivables, including batches that have been:
Created by entering cash, invoice and adjustment batches directly in Receivables.

W

Created from Adagio sub-ledgers, such as Invoices, OrderEntry, Time&Billing.
Transactions can also be created by other Adagio Third-Party programs.

IE

Created automatically by Receivables such as recurring charges, interest and
balance write-off processing.
Imported from non-Adagio programs.

This process enables Receivables to add transactions to the customer accounts that
make up Receivables. Adagio Receivables allows you to review, print and edit
batches prior to posting. Once you have posted a batch, the program assigns a
posting sequence number to each posting session, allowing you to maintain an audit
trail. Each posting session may include one or more batches created in the Cash,
Invoices or Adjustment functions.
If you provide customers with statements at the end of each month, you can run the
statements using the Reports, Statements/Letters function. Depending on the option
setup up in the Systems Options in the Company Profile, you will have the chance to
clear fully paid transactions when printing the statements. If you want to include this
function when printing statements, the Clear transaction detail by option should be set
to Billing Cycle. For further information, see Adagio Online Help text.
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Posting Batches
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This function can be performed at the end of a period as defined by the company. A
period can be a month, quarter or any time period that reflects the normal business
cycle in the customer accounts. During period end processing, interest charges can
be created for overdue accounts and bad debt amounts written off. Customer
statements can be printed during a period end, as well as clearing paid transactions
from the customers’ transaction ledger. Period end processing will transfer period-todate statistics to the year-to-date statistics, as well as updating other statistical
information for each customer.

Year End
Processing

This function is usually completed at the end of the fiscal year after the period end
processing is completed. The main function of this process is to clear the year-to-date
statistics and transfer the statistical information for the year to the previous year
statistics. This function will also reset the batch numbers to 1, preparing the system
for a new year.

FO

R

PR

EV

IE

W

O
N

LY

Period End
Processing
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Lesson 2 - Getting Started
The Adagio Accounting system is a modular accounting system. This means that each of the Adagio
Accounting modules, including Receivables, need to be started individually.
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Once you have launched Adagio Receivables, the following window appears:

1. Enter the user ID and Password provided to you by the system administrator.

W

2. Select the date that you want to use as a default for this session. This date will be used as a
default when entering transactions and printing reports.

IE

3. Select 'Remember user name' and 'Remember password' to have the Adagio user name and
password remembered and authenticated by the Windows user. This allows you to default your
Adagio user name and password by logging into Windows (on the same station).
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4. Adagio Receivables displays the session date used when you last accessed or ran the program
with the data path that initially displays in the Data path. This is specific to the user logging in.
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5. The data path and extension will default to the last opened dataset. To open a dataset in a
different location, you can either use the file finder to browse to the desired location, or the most
recent files to select a previously opened dataset. When using the file finder, the following window
will appear:
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Using your mouse pointer, navigate to the location of the dataset that you want to open. Then double click
on the ARGLOB file that appears under the Files panel.
If the ARGLOB file does not appear in the Files panel, you have either pointed to an incorrect
location, or the Receivables dataset has not been created.
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When using the Previously Opened finder, a window similar to the following will appear:

W

Select the desired Company Name, press the Open button.
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To remove an entry from this window, select the Company Name you want to remove. Click the Right
mouse button and select Remove. This simply removes the entry from the Previously Opened window – it
does not remove the dataset from your computer.

Exercise 2.1

PR

Electronics World Inc. is the company that will be used to demonstrate the functions of Adagio
Receivables through a series of exercises. Electronics World Inc. is an expanding chain of retail
computer stores and is in the process of implementing Adagio. The installation and implementation of
Adagio has been completed by the company’s Adagio consultant who has created the dataset and
entered basic information to get the company started using the Adagio Receivables module. The current
date is May 31, 2014.

R

Start the Adagio Receivables by double clicking on the shortcut
located on your Desktop. If there is no
shortcut, you can open the Adagio Receivables from Start, Adagio, and Adagio Receivables.
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In the logon windows enter May 31, 2014 as the session date. Enter the date in the format used by your
Windows operating system. You can also use the Calendar button to select the date from the calendar.
Enter the path to your dataset as C:\Softrak\Trngdata and the data extension as EWI.
When the information has been entered in the login window, click the OK button.

Note: If you already have another Adagio module open, you can open the Adagio Receivables from that
module by using the Adagio button on the menu bar. This will open the Adagio Receivables for the same
company that is being used by the open Adagio module. For example, if you are already in the Adagio
Ledger for Electronics World Inc., by selecting Adagio Receivables from the Adagio menu in the Adagio
Ledger, the Adagio Receivables for Electronics World Inc. will open.
You are now ready to proceed with the exercises contained in this courseware.
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Lesson 3 – Reviewing Receivables Options
Adagio Receivables has options that are specific to each user and workstation. This is useful when
Receivables is being used in a multi-user environment, where each user working on their own
workstations can set up Receivables to their own specific preferences.

Workstation Options
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From the File menu, select Workstation Options.
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The options selected in this section will affect anyone who logs onto the particular workstation where
these options have been selected.
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Select a Report Printer or Specification Printer to which these print jobs will be sent. The Report
Printer is the printer to which any report selected from the Reports menu will be printed, except for those
reports located in the Statements / Letters menu under the Reports menu. For example, if you have a
dedicated printer in the office where letterhead is loaded, you can select a Specific Printer to which the
customer statements or letters will be printed. If standard reports will be printed to your default Windows
printer, select the Default button and those print jobs will go to the printer that has been specified in the
Window's Printer Settings as the Default printer.
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User Preferences

General
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From the File menu, select User Preferences.
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By Application

FO

The first panel provides options that control the appearance of Adagio Payables' Menu, Toolbar and
Status bar. For example, if you want to fax or email payment advices to vendors, you must first include
these items in the menu bar. You can also select the options that control the appearance of the Toolbar.
If you are resizing and repositioning entry forms, e.g. Invoice entry form, you can select the options to
Save window position and Save window size. When these options are selected, the size and position
of these windows will be saved and will open to how they were set in the last session next time Payables
is opened.

You can also select the option to Auto-advance smart finder that will advance to the next item displayed
in the Smart Finder listing after the first item has been selected for editing. This is useful if you are
reviewing or editing vendors that meet a certain criteria where you do not have to redo the Smart Finder
each time you have finished reviewing or editing a particular vendor.

Using Adagio Receivables
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Select Implied decimal if you want the program to automatically place the decimal in an amount the
number of spaces from the left depending in the currency's number of decimal places. When this option
is selected, it will affect all modules company-wide.
When selecting Alphabetically sorted field list you will be able to sort the field lists within Grid Filters
Edit and the Column Editor. This is useful for field lists that are lengthy from which you want to find the
desired field quickly.
By selecting Implied decimal the program will insert a decimal two decimals from the left of the last digit
entered.
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Selecting Auto add entry will allow you to add line items in the details form without having to return to the
header each time a line item is entered. This is particularly useful if you enter invoices with more that one
detail line on a regular basis. When Remember batch entry fields is selected, the program will keep the
entry in the header fields each time a new document is entered. Once you have exited the data entry
function, the data in the header fields will be reset.
In the Grids and Finders section, you can override the applied filter styles for records seen in grids and
Finder/SmartFinder windows and apply your own style of banding instead. On windows that display the
Filters dropdown, the true filter styles will continue to display in the Filters dropdown.

EV

•

W

•

Ignore stye properties – enable this option if you want to override the styles applied to Payables
records by filters with your own style.
Color every [] rows – this field is only active if Ignore style properties is enabled. Enter the
number of rows you want to apply your style to. For example, if 5 is entered, your style
background will be applied to records 1-5, 11-15, 21-25, etc. Records 6-10, 16-20, 26-30, etc.
will have no style applied to them at all.
Row Backg – use this field to select the color you want to apply as the Row Background for
records affected by your Color every [] rows selection. Select an existing color in the palette or
Define a Custom Color and Add it to the Custom Colors palette.
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The next section allows you to select options for emailing and faxing.

PR

Auto Add Entry will automatically add items when entering documents will allow you to add multiple
items in the detail section of the document without having to manually add a new detail for the document.
For example, if you are entering a document with a number of line items, you will probably want to select
this option so that after entering each line item, you are returned to the detail section rather than the
invoice header.

R

Remembering batch entry fields should be selected if you want the program to remember the customer
code, document type, date, reference and description for each document entered.

FO

Include inv. # in remembered sett. option is only active if Remember batch entry fields is turned on.
This option to instruct Adagio Receivables to also remember the Document code used entry within this
batch.
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By Company
The next panel provides you with the options as to which window(s) you want opened automatically when
launching the program. You can select as many as you require. When opening multiple windows, it is a
good idea to resize and reposition each of the windows to make your desktop manageable. Otherwise,
the windows will be stacked on top of each other.

Appearance
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Select the Appearance tab for reviewing the options that control the appearance of the company's
desktop.

In this window, you can select a Background color for the desktop, place an image or text on the desktop
to identify the company that you are working with. This option is useful if you are working with multiple
companies and want to easily identify the company that is currently open. You can also select the
preferences for displaying the text or graphic on the desktop, as well as scaling the image to fit the
Adagio desktop.
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Report Options
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Select the Report Options tab to select the various options that affect the printing and previewing of the
Payables' reports.

EV

These options affect the specific company and control the appearance of the reports. When Remember
report settings? is selected, the program will remember the parameters of the specific report being
previewed or printed. The ranges can be excluded from being 'remembered' by selecting the Exclude
ranges option.
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While the various options for the report formats are are self-explanatory, you can refer to the
documentation available with the Adagio Receivables program for additional information, or pressing the
Help button.
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Finally, when logged in as SYS, all of the users' preferences can be reset to those selected by the Adagio
System administrator by clicking on the Set All Users button. However, if the individual users have
access to the User Preferences, they will be able to change these options to suite their own preferences.

Exercise 3.1

From the User Preferences function, select the EWI.JPG as the logo for your Receivables desktop.
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Create Write Off Batch, 116
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customer statements, 3
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Account set code, 41
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Account Types

Customer Statements
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Printing customer statements, 3, 129
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Bank code, 36, 60
Batches
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Adjustmemt, 3, 19, 34, 67, 94
Cash, 3, 23, 29, 30, 33, 34, 36, 59, 60, 72, 89,
94, 107, 108, 109, 110, 138
Creating batches, 3
Invoice, 3, 11, 22, 23, 29, 30, 34, 37, 38, 46,
47, 49, 50, 63, 64, 67, 77, 85, 95, 98, 99,
100, 101, 104, 106, 107, 108, 109, 110,
112, 115, 119, 133, 143
Posting batches, 3

Calculate Customer Aging, 123, 124
Charging Interest, 115
Clear History, 123
Clearing transactions
Billing Cycle, 3, 42
Comments

Daily processing
adjustment batches, 94
document preparation, 95
invoice batches, 92, 93, 94, 95, 106
processes transactions, 94
processing receipts, 107
receipt batches, 94

comments, 1, 69, 70, 76
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Deleting Inactive Customers, 127

Printing Statements
Clear transactions, 3, 19, 115, 129, 146

Document type

Recover posted batches, 144

Credit note, 82, 98
Debit note, 98
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Invoices, 107
Retainage Invoice, 98

Recurring charges
recurring charge, 63, 64, 65, 85, 91, 119, 121
updating recurring charges, 121
Report group, 24, 71, 132

Filters, 11
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Styles

Inquiries

Styles, 15, 136, 137

company aging, 142
customer inquiries, 142

Syles
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Filter, 15, 19, 70, 136, 137

Maintaining Specifications, 152

User Preferences
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Period End Procedures, 114
Period End Processing,
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bad debt write-off, 4
Clearing paid transactions, 4
Keeping transaction history, 19
Process interest charges, 4, 21, 42, 72, 94,
114
Transferring period-to-date statistics, 4
Updating statistical information, 4
Posting

Alphabetically sorted field list, 11
Appearance, 12
Auto add entry, 11
Auto-advance smart finder, 10
By Application, 10
Color every [] rows, 11
Grids and Finders, 11
Ignore stye properties, 11
Implied decimal, 11
Remember batch entry fields, 11
Remember report settings, 13
Row Background, 11
Save window position, 10
Save window size, 10
Smart Finder, 10, 11
User Preferences, 10, 13
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alert, 75, 76, 77, 89
alerts, 1, 68, 75, 76, 89
disable, 76, 77, 89
notes, 1, 3, 23, 29, 68, 70, 75, 76, 94, 95, 98,
106, 118
purge notes, 75
Require confirmation, 77
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Notes / Alerts, 75

User Presferences
Background color, 12
Using Filters, 136
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ready to post, 96

FO

Printing reports

Batch Status, 144, 150
customer reports, 138
Print/Delete Favorites, 140
report favorites, 140
transaction reports, 138

Workstation Options
default Windows printer, 8
Report Printer, 8
Specific Printer, 8
Specification Printer, 8
Workstation options, 8
Year End, 4, 32, 85, 150

Printing Reports
setup reports, 138

Year End Processing
Clear the year-to-date statistics, 4

To order, please contact your Adagio Reseller or
contact sales@lng.bc.ca. Visit our website at www.lng.bc.ca.
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